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After completing this section, students will be able to: - 
• define adobe xd 
• describe purpose of adobe xd 
• define home screen 
• understand workspace 
• create and use artboards 
• define design view 
• understand prototype view

(Section-I) 

Adobe XD 

Adobe Illustrator



Adobe XD is a vector-based UI and UX design tool and it
can be used to design anything from smartwatch apps
to fully fledged websites. Let’s take a look at what it offers
to designer and why it has become such a powerful tool
in the web design industry. 

5.1 Adobe XD 

The main purpose of Adobe XD is to addresses the two
main problems that Photoshop and other graphics
applications couldn’t: 

1- Interaction design isn’t static. A designer cannot
communicate a fluid and dynamic design using pixels
alone

Purpose 

Adobe XD is ideal for vector-based UI design, wireframing,
interactive design, prototyping, and hi�fidelity web/app
design, for solo designers or whole teams

2- A modern design process involves more than a
polished finished article. Wireframing, iteration, and
behavior are all part of the collaborative decision making
with UI and UX design.

Home screen 
The Home screen gives you quick access to learn tab, cloud
documents, shared with you and deleted, manage links,
artboard presets, and recent files. 



Workspace overview 

A.Home B. Learn C. Cloud documents D. Shared with you
E. Deleted F. Manage links G. Recent files H. Artboard
presets 

The workspace of Adobe XD consists of following
components as can be seen in Figure 9.2

A. Main menu B. Design mode C. Prototype mode D. Share
mode E. Preview on device F. Preview G. Zoom percentage
H. Property Inspector I. Pasteboard J. Artboards K. Plugins
L. Layers M. Libraries N. Toolbar



Artboards represent the screens in your application or
pages in your website. It streamlines the design
processes and creates interactive designs for multiple
screen sizes in a single document. Use artboardsto
create your XD project.

Create a new artboard 

5.2 Art Board

Adobe XD provides you with artboards for popular screen
sizes such as those for different versions of iPhones, iPads,
and Web. You can create a custom artboard if the
choices do not meet your requirements. As can be seen
in figure 5.1



A design view is a means of organizing design information. It
expresses a design in terms of a set of design entity(s) . A
complete design describes all design entities and their
attributes. In contrast a design view looks at:

A subset of the design entities where the design view
gives design information about part of the system (for
example a particular sub-system).

5.3 Design View 

A subset of the design attributes where the design view
gives a certain type of information about the entire
system (for example the functional safety aspects of the
design).

Both the design entities and design attributes subsets
where the design view gives a certain type of information
about part of the system (for example component
interface specifications).



The Share mode in XD consolidates different sharing
capabilities into a centralized location and makes
sharing your designs and collaborating with stakeholders
and designers a breeze reference in figure 5.2.

5.4 Prototype View

You can use the built-in presets, such as Design Review,
Development, Presentation, User Testing, and Custom to
share your documents and manage your shared links.

Figure 5.2



After completing this section, students will be able to: -

In Section-II of this chapter:

(Section-II) 

• learn fundamental aspects of adobe xd 
• work with user interface and wireframe kits 
• understand the usage of masks 
• work with point and are type 
• create and edit vector shapes 
• use the repeat grid function 
• create and work with symbols 
• export assets 
• use comments to get feedback
5.5 Fundamental aspects of Adobe XD

Repeat grid 
Helps creating a grid of repeating items such as lists, and photo
galleries. 

Prototype and animation 
Creates animated prototypes through linking artboards. These
prototypes can be previewed on supported mobile devices.

Interoperability 
XD supports and can open files from Illustrator, Photoshop,
Photoshop Sketch, and After Effects. In addition to theAdobe
Creative Cloud, XD can also connect to other tools and services
such as Slack and Microsoft Teams to collaborate. XD is also able
to auto-adjust and move from macOS to Windows. For security,
prototypes can be sent with password protection to ensure full
disclosure.



Design and edit components without the nudging or the tinkering.
Content-Aware Layout aligns and evenly

Interoperability 

spaces as you add, remove, or resize objects. Make adjustments
with smart controls and get back to exploring.

Voice design 
Apps can be designed using voice commands. In addition, what
users create for smart assistants can be previewed as well.

Users can create components (previously known as symbols) to
create logos, buttons and other assets for reuse. Their
appearance can change with the context where they are used.

Components 

Responsive resize 
Responsive resize automatically adjusts, resizes pictures and
other objects on the artboards. This allows the user to have their
content automatically adjusted for different screens for different
sized platforms such as mobile phones and PCs.

Plugins 
XD is compatible with custom plugins that add additional
features and uses. Plugins range from design to functionality,
automation and animation.

5.6 Wireframe 
Any website or app starts with wireframes — simple line drawings,
like blueprints, that lay out the size and structure of page
elements, navigation, and site features. They help stakeholders
and other teams focus on and understand the flows, content
states, and elements of the design.



Working with Wireframe 

1. Start with basic shapes

Select the appropriate size for your first artboard, based on the
device or devices the design will be used on. You can either
select a preset size, or if there isn’t a preset, specify a custom
size.

Double-click on the artboard’s title at its top left corner to name it.

As you add objects to the artboard, think about the purpose and
intent of each and how you want the user to interact with them. Keep
the shapes simple, only as complex as necessary to make your point,
and let the mind draw in the details, refer to the image below:

Figure 5.3 

2. Use shapes as image placeholders 
Basic shapes, such as rectangles and circles, can serve as placeholders
for imagery. If you want to include images in your wireframes, use simple
shapes to represent them. Refer to the Image below: 



3. Save time with symbols 
If you’re trying to display an interaction, many of the screens in your app will be
very similar, much like a movie — repeating the same main objects, like menu
bars and headers, in every screen. No need to draw them from scratch every
time you add a new artboard. Instead, convert your objects into Symbols that are
easy to place throughout your artboards. They stay linked, so when you update
one, you update all.

Figure 5.4

4. Arrange artboards 
You can marquee select (drag select) or hold down Shift and select to pick up
multiple artboards and move them. You can also use the Arrange buttons or the
Arrange option in the menu to arrange the selected artboards.



6. Animate your wireframe 

Grids let you align objects and text with guides. When you draw,
objects snap to the grid automatically when the object’s edges
are within the grid’s snap-to zone. Grids also help you get a quick
idea of measurement while laying out objects or text on your
artboards as can be seen in figure 5.7. 

5. Design in grids 

Figure 5.7 

Once you have a series of artboards, link them together with
animations — known as “wiring the app” to show how they
interact. Adobe XD lets you define transition types between
screens: Slide Left, Slide Right, Slide Up, Slide Down, and Dissolve.
You can also define the easing and the duration of the transition
itself. Adobe XD defaults to the most recent settings you choose,
so it can speed up the process of wiring your app if you batch
many transitions of one type together, refer to the image below:



Now it’s time to preview your work. You can share your design by sending a link or
embedding it in a web page, and you can enable comments if you want feedback. You
can also record a walkthrough as a ‘.mov’ file. Open the Adobe XD file that you want to
share, and click the Share Online icon. Name it and click New Link, and XD will give you a
URL. When you make changes to your design and want to refresh the URL, click Update
Link. You can open it in either the Preview window or in full screen. You can also use
Preview to record the interactions. If you need to make corrections, you can do so while
still keeping the Preview window open. Just make your changes to your prototype, and
they’ll update immediately as can be seen in figure 5.9.

7. Share your wireframe 

Figure 5.9 



7. Share your wireframe 
Now it’s time to preview your work. You can share your design by sending a link or
embedding it in a web page, and you can enable comments if you want feedback.
You can also record a walkthrough as a .mov file Open the Adobe XD file that you
want to share, and click the Share Online icon. Name it and click New link, and XD will
give you a URL. When you make changes to your design and want to refresh the URL,
click Update Link. You can open it in either the Preview window or in full screen. You
can also use Preview to record the interactions. If you need to make corrections, you
can do so while still keeping the Preview window open. Just make your changes to
your prototype, and they’ll update immediately.

Once you have a series of artboards, link them together with animations — known
as “wiring the app” toshow how they interact. Adobe XD lets you define transition
types between screens: Slide Left, Slide Right, Slide Up, Slide Down, and Dissolve.
You can also define the easing and the duration of the transition itself. Adobe XD
defaults to the most recent settings you chose, so it can speed up the process of
wiring your app if you batch many transitions of one type together, as can be seen
in figure 5.11. 

6. Animate your wireframe



5.7 Masking 

Figure 5.12 

Masking is a method of using a shape or object to hide, or
cut off, portions of a shape or object below it. Similar to
“cropping” an image to size, masking lets us show only the
parts of an object that we want to show as shown in figure
5.13.

Using masks can help you add excitement to your designs,
create fills of odd objects with images or gradients, and help
you create the perception of depth in your designs. We’ll
explore some examples of what can be done at the end of
this article.



5.8 Masking with text 
Masking text objects in Adobe XD can create unique effects in
your designs. Whether you want to set the background fill to be
an expansive mountain range, or a babbling brook, or you want
to mask your text object with another vector shape, it’s all
possible.

To mask a text object, it needs to first be converted to a vector
path. To do this, we’ll select the text object, and navigate to
Object > Path > Convert to Path, or hit CMD/CTRL + 8 on the
keyboard. Your text is now a vector path which we can mask like
other objects.



It is important to remember that the order of the selected
objects determines which object acts as the mask, and which is
being masked. The object on the bottom will be masked by the
object on the top. So if you’d like to set your text as the mask to
an image, ensure the text object is on top of the image layer,
and then select your “Mask with object” (Shift+CMD+M)
command to mask the image with the new text path.

Drawing masks
Creating a mask shape is very simple in Adobe XD. You can use
any of the existing shapes in XD to create a rectangle, ellipse,
triangle, or polygon. Simply click the shape on the left panel and
draw it how you’d like. For more complex situations, the pen tool
can be a powerful feature for creating complex masks. For
instance, you can use the pen tool to trace elements in a photo
to mask a very specific element of the photo as can be seen in
figure below.



5.9 Creating and editing shapes 
Creating vector artwork inAdobe XD is easy thanksto the array of
drawing tools available. If you’re coming from other Adobe
applications, you’ll find the drawing tools in Adobe XD to be streamlined
and efficient, with a few differences. For more complex vector content,
you can use Illustrator and easily bring the vector artwork into XD.

1- Choose File > Open from Your Computer (macOS), or click the
menu icon (menu_icon.jpg) in the upper- left corner of the
application window and choose Open from Your Computer
(Windows). Open the Travel_ Design.XD document in the
Lessons folder (or where you saved it).



2- Press Command+0 (macOS) or Ctrl+0 (Windows) to see all
of the content. 
3- Click the artboard name “Home” in the document window to
select that artboard. Press Command+3 (macOS) or Ctrl+3
(Windows) to zoom in. 
4- Select the Select tool and click away from the artboards to
deselect all.

5.11 Creating rectangles 
In this section, using the Rectangle tool, you’ll create a rectangle
that will be used as a button on the home screen.
Select the Rectangle tool (rectangle_tool.jpg) in the toolbar.
Near the bottom of the Home artboard, move the pointer over
the left edge of the artboard until that edge of the artboard
turns aqua. This change in color indicates that the shape will
snap or align to the edge of the artboard. Drag down and to the
right to draw a rectangle, stopping on the right edge of the
artboard. When alignment guides appear on the right, release
the mouse button. Don’t worry about the height for now, refer to
the figure below: 



5.12 Creating ellipses 
Another drawing tool you can use is the Ellipse tool. In this section, you’ll
create several circles that will be used as a button in the app footer. 

Press Command+Shift+A (macOS) or Ctrl+Shift+A (Windows) to
deselect all so that you will be able to see all of the artboards in the
Layers panel.

Click the Layers panel button (layers_panel.jpg) in the lower-left
corner or Ctrl+Y [Windows]) to open the Layers panel, if it isn’t already
open. Double-click the artboard icon to the left of the artboard name
“Icons” in the Layers panel to fit the artboard in the document window. 



5.13 Repeat Grid Function 
Simply click-and-drag to turn a single element into repeating grids.
Create sets of replicated elements like photo galleries, product
listings, contact lists, menus, and more. You can also add states to
repeat effects and interactions across elements, all at once. 

Using easy drawing, create an element to repeat. Select all the
layers and turn it into a group, refer to the figure below.

5.14 Design your first element. 



Drag it out 
With your element selected, click “Repeat Grid” and drag the
green handles in any direction to generate a grid. You can
hover over spaces between elements to adjust the distance.,
refer to the image below: 

Bring in real content 
Drag in images or import text to replace content in your grid. The grid
will automatically update with local content to make it look like the
real thing as can be seen in figure 5.21.

Figure 5.19 

Figure 5.21 



5.15 Symbol 

If you find that you are reusing objects in your Adobe XD UI, you
should consider converting them to symbols. Symbols are
linked objects that can be reused across all artboards in a
document. Because they are dynamically linked, changes to
one reflect across all instances.

To convert an object into a symbol, follow these steps:

1- Open a document that contains at least one artboard, an
icon, and some related text. In this example, we open the file
from the ‘Dummies CC files’folder named delivery
symbolsample in Adobe XD.

2- Select an object and some text that you want to reuse. In this
example, one of the grouped Submit buttons is selected.

3- Right-click (Windows) or Ctrl-click (Mac) and select Make
Symbol from the contextual menu.

If you look in the Layers panel, the object that you converted
into a symbol now has a symbol icon to the left of the name. 



If you click the Symbols icon in the lower left of the XD
workspace, you see your symbol in a thumbnail view.

5.16 Export assets 

Open your Adobe XD file and select the asset or the artboard
you want to export. To select an artboard, click the artboard
title.

You can also mark assets or artboards for export and then
export them all in bulk. To mark assets for export, open the
Layers panel and click the Mark for Batch Export icon. 

To export a JPEG on macOS, select File > Export. On Windows,
click the Hamburger menu, and click Export. There are 3 options
to export:

Batch: Export assets that are marked using the Mark for Export
option. 
Selected: Export selected assets. 
All Artboards: To export all the artboards in your design.



When you export assets(such as photos) asJPEG, you can set
the quality level of the exported JPEG according to your needs.
Choose any of the percentage options in the Quality drop-down
list, navigate to the destination folder, and click Export.

Comments and Feedback 
1- To pin or move your comments to indicate specific areas in
the artboard, click Place a pin, and then click the specific
location in the artboard as can be seen in figur 5.22.

A. Invite option B. Zoom settings C. Full screen mode D. Support
and Feedback E. Notifications F. User profile G. Menu options for
comments H. Filter comments I. Hide annotations J. All Screen
Comments toggle button 



1- Type in your comment and click Submit to submit the
comment. You can also switch from a regular comment to a
pinned comment. XD assigns a number to every pinned
comment. The comments in the comments panel also reflect
these numbers, allowing designers to easily identify the context
of the comment.
2- Use @mention while commenting to call out specific
collaborators to your feedback and notify them via email or
Creative Cloud application. @mention provides hints of their
names based on the invite settings set in the Publish dialog box
while designers share design specs.

3- Select Cancel to cancel an added comment in the
comments panel.

4- To view the comments that have been marked as resolved,
click the Filter icon, and select Resolved. 

5- To keep your comments open if they are wrongly marked as
resolved, click Move to Unresolved. 


